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Chapter 1: Introduction

About This User Guide

This e-Link Online User Guide has two sections. The first section 
provides instructions for using the Jeppesen e-Link Online portal to 
access navigation data and documents. 

The second section provides user administration instructions for 
setting up and maintaining the e-Link Online portal, including 
uploading company-specific documents. 

Intended Audience

This document is designed for:

• Pilots, dispatchers, and flight planners who use Jeppesen Chart 
Viewer and the e-Link Online portal to access flight 
information.

• Data administrators who ensure that electronic flight 
information is available for flight operations.
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Where to Find Additional References

In addition to this e-Link Online User Guide, online help is 
available from within: 

• Chart Viewer

• CAT

• DDM

Product Support

Jeppesen Global Support and Control Center (GSCC) provides 
multiple levels of support around the clock for the e-Link Online 
portal and its services, ensuring ready access to flight-critical 
information anywhere, at any time.

Western Hemisphere

• 1-800-538-7526 (Toll-free)

• 303-328-6830 (US local)

Eastern Hemisphere

•  +44-1293-842406 (UK)

• +49-6102-508450 (Frankfurt, DE)

Pacific Basin 

• 1-800-256-181 (Toll-free)

• +61-731-248-250 (Brisbane)

Email: gscc@jeppesen.com
Jeppesen e-Link Online User Guide January 2014
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NavData Support

For specific assistance with electronic data downloads, you can 
contact NavData Technical Support at:

• 303-328-4445 (US local)

• Email: navdatatechsupport@jeppesen.com
January 2014 Jeppesen e-Link Online User Guide
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Chapter 2: Overview

The Jeppesen e-Link Online portal provides access to the most 
current electronic charts, documentation, and other flight 
information via the Internet.

System Requirements

The system requirements for using the e-Link Online portal are 
the same as the requirements to run your choice of the following 
web browsers:

• Microsoft Internet Explorer

• Mozilla Firefox

• Apple Safari 

• Google Chrome

The Chart Viewer application operates on Windows, Mac, and 
Linux operating systems and can be used with Internet Explorer, 
Firefox, Safari and Chrome web browsers. A PDF viewer is 
required to view documents and print-based compositions. 
Jeppesen e-Link Online User Guide January 2014
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Getting Started

Logging In to the e-Link Online Portal

To log in to the e-Link Online portal: 

1. Open your browser and navigate to: 
http://www.jeppesen.com

2. Select the ACCOUNT/LOGIN Jeppesen Customers box 
at the top right of the page.

3. Select Aviation Account.

4. Enter your e-Link Online user name and password.

5. Select Login.

NOTE Your user name and password are case-sensitive.

If you have forgotten your e-Link Online user name or 
password, select Forgot Username/Password? and enter the 
requested information. Your login information will be sent to you 
via email.

Logging Out of the e-Link Online Portal

Logging out of the e-Link Online portal returns you to the 
Jeppesen home page. When you log out, always use the portal 
log-out procedure. 

To log out:

• Select Logout at the top right on the page.

NOTE  If you close the browser without first logging out, as a 
security measure, the Jeppesen server holds the session ID, 
and prevents you from logging in until you log out or until the 
session ID expires. 
January 2014 Jeppesen e-Link Online User Guide
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Chapter 3: e-Link Online

The services and menu items that are available to you from the e-
Link Online portal vary based on your account permissions.   

Menu
Jeppesen e-Link Online User Guide January 2014
Copyright © 2014 Jeppesen. All rights reserved.
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The Chart Viewer Application

Jeppesen Chart Viewer is a chart-viewing application that is 
platform independent. With Chart Viewer, you can:

• View and print charts

• Access and print airport information, including chart 
change notices

• Create and print RoutePacks

• Access and print manuals 

• Access and print company-specific documents

Launching Chart Viewer

To launch Chart Viewer:

• From the e-Link Online portal, select Launch Chart 
Viewer.

Chart Viewer Windows

Chart Viewer provides two main windows: the Finder window on 
the left, and the Viewer window on the right. 

Use the Finder window to locate airport information, terminal 
charts, change notices, text, revision letters, and RoutePacks. 

The Viewer window displays the information retrieved from the 
Finder window.

Finder Window Viewer Window
January 2014 Jeppesen e-Link Online User Guide
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Chart Viewer—Finder Window

Depending on your account setup, the Finder window might 
display information organized under three tab selections: Charts, 
Manuals, and Revision Letters.

Resizing the Finder Window

To resize the Finder window, drag the vertical divider between 
the Finder window and Viewer window. 

The data columns within the Finder window maintain their 
widths and do not resize when you resize the Finder window 
itself. If the data columns are too wide for the current section size, 
a horizontal scroll bar appears so that you can scroll to view all of 
the data columns.

Chart Viewer—Viewer Window

Depending on the type of selected information, the information 
that appears in the Viewer window can be panned, magnified, 
rotated, and searched.

You can zoom in, zoom out, and zoom rectangle using the 
buttons, the plus (+) and minus (-) keyboard keys, or the mouse 
wheel.

See Table 1-1, “Chart Viewer Tools" for a detailed list of the 
Viewer window tools.

Table 1-1 Chart Viewer Tools 

Fit to Width Displays information within the 
width and flush with the top of 
the Viewer window. Use the 
mouse to click and drag the 
chart.

Fit to 
Window

Displays information within the 
entire Viewer window.
Jeppesen e-Link Online User Guide January 2014
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Fit to Bottom Displays information fit to the 
bottom of the Viewer window.

Zoom Out Zooms out on the item in the 
Viewer window.

Zoom In Zooms in on the item in the 
Viewer window.

Zoom 
Rectangle

Draws a zoom box. The chart 
zooms into the area of the box. 
Press the Esc key to terminate 
this action.

Pan Drag Pans and drags the chart in the 
viewer window. You can also 
use click-and-drag with the 
mouse, or the up, down, left, and 
right arrow keyboard keys.

Rotate Left Rotates the image in the Viewer 
window counter-clockwise.

Rotate Right Rotates the image in the Viewer 
window clockwise.

Convert to 
PDF

Converts the displayed document 
into a PDF file that you can print, 
save, or email.

Expand/ 
Restore 
Chart Frame

Expands or restores the chart 
frame to, or from, full frame 
viewing.

Table 1-1 Chart Viewer Tools (continued)
January 2014 Jeppesen e-Link Online User Guide
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Resizing the Viewer Window

You can resize the Viewer window in either of two ways:

• Drag the vertical frame divider between the Finder and 
Viewer windows to the left or right. 

• When viewing a chart, select the Expand/Restore Chart 
Frame button at the top of the Viewer window to switch 
between expanded Viewer window and restored Finder and 
Viewer window split.

Chart Viewer Menu

The Chart Viewer menu provides four menu options: File, Edit, 
View, and Help. 

File

Select File from the Chart Viewer menu for a list of file actions. 
Table 1-2, “File Options" describes the available options .

Edit 

Select Edit from the Chart Viewer menu to open the Preferences 
dialog box. You can set preferences that are restored each time 
you open the Chart Viewer application. Table 1-3, “Preferences" 
describes all of the preferences that you can set.

Table 1-2 File Options

Print All 
Selected 

Prints all of the items selected in the Finder 
window. 

Open 
RoutePack 

Opens the Load RoutePack dialog box.

New 
RoutePack

Opens the Create RoutePack dialog box.

Exit Closes the Chart Viewer application.
Jeppesen e-Link Online User Guide January 2014
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View

Select View from the Chart Viewer menu to access the available 
tab views that are available in the application. The tab views are: 
Charts, Manuals, and Revision Letters.

Help 

Select Help from the Chart Viewer menu to access the Chart 
Viewer online help and open a dialog box that displays 
information about the product and version.

Preferences

To set preferences, select Edit from the Chart Viewer menu, and 
then select Preferences. Table 1-3, “Preferences"describes the 
preferences that you can specify.

NOTE You must enable cookies on your browser to ensure 
that your preferences are not discarded when you exit the 
application.   

Table 1-3 Preferences  

Coverage 
Options tab

You can specify the coverage display style 
and the coverages that are used when you 
search for an airport in the Finder window.

Options are:

• Coverage code and name.

• Coverage name only.

• Coverage code only.
January 2014 Jeppesen e-Link Online User Guide
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Chart 
Options tab

You can set default chart-viewing options for: 

• Chart display style. See Table 1-4, 
“Default Chart Display Styles" for a 
detailed list of options.

• Mouse drag operations. See Table 1-5, 
“Mouse Drag Operations" for a detailed 
list of options.

• Initial chart sort order. See Table 1-6, 
“Initial Chart Sort Orders" for a detailed 
list of options.

• Initial airport location.
When you specify an initial airport 
location, the application displays that 
airport and all of its charts every time 
you open Chart Viewer. Enter a three-
character IATA or four-character ICAO 
airport code. 

Enroute 
Options tab

Viewing Enroute from within the Chart 
Viewer application is an optional service. If 
you subscribe to the service, the Enroute 
Options tab is available from the Chart 
Viewer Edit > Preferences menu. 

Some enroute elements are visible only at 
certain enroute zoom levels. See Table 1-7, 
“Enroute Elements" for a detailed list of 
enroute elements.

Print Options 
tab

All preferences set in your print options can 
be changed by your local printer driver when 
you print.

See Table 1-12, “Print Options" for an 
explanation of each of the print options.

Table 1-3 Preferences (continued) 
Jeppesen e-Link Online User Guide January 2014
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Table 1-4 Default Chart Display Styles 

Fit To 
Width

The chart appears across the width of the 
Viewer window.

View Full 
Image

(Default setting) The entire chart appears in the 
Viewer window, regardless of the Viewer 
window proportions.

Fit To 
Bottom

The bottom portion of the chart appears in the 
Viewer window.

Table 1-5 Mouse Drag Operations 

Pan-drag 
mode

The default operation of a mouse click-and-
drag action is to pan the chart.

Zoom-rect 
mode

The default operation of a mouse click-and-
drag action is to draw a zoom rectangle within 
an area on the chart.

Table 1-6 Initial Chart Sort Orders

Unsorted (Default setting) When the application starts, 
leave the chart sort order as the current 
behavior.

Standard 
Airway 
Manual

When the application starts, sort the charts in 
the same order as they appear in the Standard 
Airway Manual. 

The Standard Airway Manual sort option is 
applied only when all of the charts are 
referenced from a single coverage.

Ascending 
by Index

When the application starts, sort the charts in 
ascending order.

Descending 
by Index

When the application starts, sort the charts in 
descending order.
January 2014 Jeppesen e-Link Online User Guide
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Table 1-7 Enroute Elements

ARTCC/FIR/UIR 
Boundaries

Displays or hides FIR/UIR boundaries 
on the map.

Airports Displays or hides IFR airports on the 
map.

Enroute Airspace 
Fixes

Displays or hides enroute 
intersections on the map.

Grid MORAs Displays or hides grid MORAs 
(minimum off-route altitudes).

High Airways Displays or hides high-altitude 
airways.

Holding Patterns Displays or hides holding patterns.

Hydrography Displays or hides inland water (rivers, 
lakes, and so on) but not oceans.

Localizers Displays or hides localizers.

Low Airways Displays or hides low-altitude 
airways.

Low-Use Airports Displays or hides low-use airports.

NDBs Displays or hides enroute and 
terminal NDBs.

Obstacles Displays or hides known obstacles 
such as buildings, radio towers, trees, 
and so on.

Political Boundaries Displays or hides boundaries such as 
states, provinces, and countries.

Railroads Displays or hides railways.

Special Use Airspace Displays or hides special use airspace 
including restricted airspace.

Terminal Airspace Displays or hides terminal airspace.

Terminal Airspace 
Fixes

Displays or hides terminal airspace 
fixes.
Jeppesen e-Link Online User Guide January 2014
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Terrain Displays or hides graduated surface 
terrain.

Urban Areas Displays or hides high population 
areas.

VFR Airports Displays or hides VFR airports. 

VORs Displays or hides VORs.

Table 1-7 Enroute Elements (continued)
January 2014 Jeppesen e-Link Online User Guide
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Accessing Terminal Charts

From the Charts tab, you can:

• Search for an airport.

• View and print terminal charts for the selected airport.

• View and print terminal chart change notices.

• View enroute elements. (Note that the ability to view 
enroute elements is an optional service.)

• Open and create a RoutePack.

Search for an Airport

To search for an airport:

1. From the Chart Viewer Finder window, select the Charts 
tab.

2. Select the Search tab.

3. Enter the airport identifier in one of these formats:

• Airport name (for example, Kennedy Intl).

• 4-letter ICAO airport code (for example, KJFK).

• 3-letter IATA airport code (for example, JFK).

• City name, spelled out, not abbreviated (for example, New 
York, not NY).

• Any two or more consecutive alpha-numeric characters in 
the airport name, or any number in the ICAO or IATA code 
(for example, AYVN or 40G).

4. Select Search.

NOTE When you enter an airport identifier, the application 
replaces the default airport with the airport that you specify 
when you select the Search button.
Jeppesen e-Link Online User Guide January 2014
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Select a Coverage to Limit Airport Searches

To select a coverage and limit airport searches:

1. From the Chart Viewer Finder window, select the Charts 
tab.

2. Select the Search tab.

3. Select the Select Coverage button. 

See Table 1-8, “Select Coverages Options" for an explanation of 
each of the four coverage options in the Select Coverages dialog 
box.

4. Click OK to save your selected coverages and limit 
your search. 

Browse Airports by Coverage

To browse airports in a specific coverage area:

1. From the Finder window; select the Charts tab.

2. Select the Browse tab. 

3. Select the Select Coverage button; then select a coverage 
area from the list and select OK.

Table 1-8 Select Coverages Options

Select All Selects all of the coverages in your 
subscription.

Deselect All Deselects all coverages.

Load 
Preferences

Loads the coverages that you set in the 
Coverage Options in Preferences.

Save 
Preferences

Saves the selected coverages as the default 
value for coverage selection preferences.
January 2014 Jeppesen e-Link Online User Guide
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Use Airport Filters to Limit the Terminal Charts 
that Display

To limit the number of charts displayed use airport filters. 

1. From the Finder window, select the Charts tab.

2. Select the Browse tab.

3. Select an airport filter.

 Table 1-9, “Airport Filters" describes the filter options. 

Table 1-9 Airport Filters

All Airports Displays all of the airports in that coverage.

Current 
Revision 
Cycle Only

Limits the list to display only the airports that 
have revised charts in the current revision 
cycle.

Revised 
Since

Limits the list to display only the airports that 
have charts that have been revised since the 
date you enter and based on a selected 
coverage.
Jeppesen e-Link Online User Guide January 2014
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Use Chart Filters to Limit the Terminal Charts that 
Display

To further limit the number of charts that appear, select any one 
of the chart filters. Table 1-10, “Chart Filters" describes the chart 
filter options. 

View Terminal Charts

To select a terminal chart to view:

1. From the Finder window, select the Charts tab.

2. From the Search tab, search for and select an airport.

3. Select a chart from the list of charts for the airport. 
The chart appears in the Viewer window.

Table 1-10 Chart Filters 

All Charts Displays all of the charts available for that 
airport.

Current 
Charts

Displays only the charts that are currently 
effective.

Changed 
Charts 
Current 
Cycle

Limits the list to display only the charts that 
are in the current revision cycle.

Revised 
Since

Limits the list to display only the charts that 
have been revised since the date that you 
enter.

Approach Displays or hides approach charts.

Airport Displays or hides airport information.

Departure Displays or hides departure charts.

Arrival Displays or hides arrival charts.

Airspace Displays or hides airspace charts.

Noise Displays or hides noise-abatement diagrams.
January 2014 Jeppesen e-Link Online User Guide
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Sort Terminal Charts

The initial chart sort order is determined by the preferences that 
you specify under Edit > Preferences > Chart Options from the 
Chart Viewer menu.

Additionally, you can change the sort order of the chart by Index, 
Procedure ID, Revision Date, and Effective Date. 

To change the sort order of displayed charts from the chart title 
bar, select ascending or descending order for the column by 
which you want to sort. 

To return to the Standard Airway Manual chart sort order, select  
the SAM Order button.
Jeppesen e-Link Online User Guide January 2014
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Print All Charts Associated with an Airport

You can print terminal charts, save them, and send them as email 
attachments.

To print all charts for a selected airport:

1. From the Chart Viewer Finder window, select the Charts 
tab.

2. At the end of the airport row, select the Tools button.

3. Select Print [Airport].

4. Select your printing preferences. See Table 1-12, “Print 
Options"for detailed information about printing options.

5. Select Submit.
The application opens a separate window, notifies you that 
your print job is being prepared, and displays a progress 
bar. When the print job is complete, the application displays 
a PDF in this window. 

You can save the PDF, send it as an email attachment, or print it 
by using the toolbar at the top of the PDF window.

NOTE When a chart is saved as a PDF, sent as an email 
attachment to a different location, and then printed on a 
different physical printer, the person making the print is 
responsible for verifying printer settings. Printer settings cannot 
be stored within a PDF file.

Print a Single Terminal Chart

To print a single terminal chart:

1. From the Finder window, select the Charts tab.

2. From the Search tab, search for and select an airport.

3. Right-click the terminal chart from the list of charts for that 
airport.

4. Select Print [Chart].
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5. Select your printing preferences.
See Table 1-12, “Print Options"for detailed information 
about printing options.

6. Select Submit.
The application opens a separate window, notifies you that 
your print job is being prepared, and displays a progress 
bar. When the print job is complete, the application displays 
a PDF in this window. 

You can save the PDF, send it as an email attachment, or print it 
by using the toolbar at the top of the PDF window.

NOTE When a chart is saved as a PDF, sent as an email 
attachment to a different location, and then printed on a 
different physical printer, the person making the print is 
responsible for verifying printer settings. Printer settings cannot 
be stored within a PDF file.

Print Selected Terminal Charts

To print all selected terminal charts: 

1. From the Finder window, select the Charts tab.

2. From the Search tab, search for and select an airport.

3. Select the charts that you want to print.

4. From the Chart Viewer menu, select File > Print All 
Selected.

5. Select your printing preferences.
See Table 1-12, “Print Options"for detailed information 
about printing options.

6. Select Submit.
The application opens a separate window, notifies you that 
your print job is being prepared, and displays a progress 
bar. When the print job is complete, the application displays 
a PDF in this window. 
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You can save the PDF, send it as an email attachment, or print it 
by using the toolbar at the top of the PDF window.

NOTE When a chart is saved as a PDF, sent as an email 
attachment to a different location, and then printed on a 
different physical printer, the person making the print is 
responsible for verifying printer settings. Printer settings cannot 
be stored within a PDF file.

View Terminal Chart Change Notices

To view terminal chart change notices:

1. From the Finder window, select the Charts tab.

2. Select the Search tab.

3. Select the Select Coverage button, and select a coverage 
area from the list, and then select OK.

4. Enter an airport name and select Search. 
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5. Select the airport in the airport list.
Terminal Chart Change Notices, if available, are displayed 
to the right, in the Viewer window, under Airport 
Information as shown below.  

Print Terminal Chart Change Notices and 
Other Airport Information

To print terminal chart change notices and other airport 
information:

1. From the Finder window, select the Charts tab.

2. From the Search tab, search for and select an airport.

3. From the Chart Viewer menu, select File > Print All 
Selected. 
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4. Select your printing preferences. 
Under Related Documents, select Airport Info and 
Change Notices..

See Table 1-12, “Print Options"for detailed information about 
printing options.

5. The application opens a separate window, notifies you that 
your print job is being prepared, and displays a progress 
bar. When the print job is complete, the application displays 
a PDF in this window. 

You can save the PDF, send it as an email attachment, or print it 
by using the toolbar at the top of the PDF window.
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View Enroute Charts

To view enroute elements from within the Chart Viewer 
application:

1. From the Chart Viewer Finder window, select the Charts 
tab.

2. From the Search tab, search for and select an airport.

3. Right-click the airport, and select Show Enroute.         

Enroute elements appear in the Viewer window.   

NOTE Airports and helipads that do not have a published 
latitude/longitude are not shown on the enroute chart.

Set Enroute Object Viewing Preferences

You can view enroute elements from within the Chart Viewer 
application when the Chart Viewer Enroute Privilege has been 
granted through the User Administration > Manage Groups page.
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If available, you can preferences for showing or hiding enroute 
elements:

1. From the Chart Viewer menu, select Edit > Preferences. 

2. Select the Enroute Options tab.  
Select your preferences for the elements that you want 
to be shown on the enroute chart.  See Table 1-7, 
“Enroute Elements" for a detailed list of enroute elements.

Navigate the Enroute Chart

Navigate around the enroute chart using any of the controls 
located at the top of the Viewer window. See Table 1-1, “Chart 
Viewer Tools" for a detailed list of the Viewer window tools.

View Enroute Information

To view enroute information:

1. Select an enroute item in the Viewer window.
A Select an Item dialog box displays.

2. Select one of the rows to view information about that 
enroute item. 
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RoutePack Basics

A RoutePack can be thought of as an electronic briefcase that 
contains flight information for one or more routes with each 
route’s associated airport charts. You can save and unload 
RoutePack files, and then reload them for future use.

Access to RoutePacks is located at the bottom of the Chart 
Viewer Finder window when the Charts tab is selected. You can 
also access RoutePacks from the Chart Viewer File menu.

Open a RoutePack File

To open a RoutePack file:

1. From the Chart Viewer menu, select File > Open 
RoutePack.

2. Enter the RoutePack file name, or click Browse to open a 
browser window to locate the .crf RoutePack file. 

3. Select Submit.

NOTE  When the RoutePack is opened and processed, the 
Chart Viewer application updates all of the associated charts to 
the current version. If the RoutePack was created in another 
application and the charts are not in your current coverage, they 
will not be updated.

Close a RoutePack File

To close a RoutePack file:

• Right-click the top level of the RoutePack and select 
Unload RoutePack.
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View a RoutePack

To view a RoutePack without opening it:

1. From the Finder window, select the Charts tab.

2. Select the Expand button at the bottom of the Finder 
window.

3. Select the RoutePack name.

4. Expand and collapse the Route to view the routes and  
charts.

Create a New RoutePack

To create a new RoutePack:

1. From the Finder window, select File > New RoutePack. 
The application opens the Create RoutePack dialog box. 

2. Enter a name for the new RoutePack and select Submit. 

• In this example, create a RoutePack for a flight from 
Hyderabad to Arlanda. Enter the RoutePack name VOHY 
to ESSA.
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Add an Origin Airport to the RoutePack

1. From the Finder window, select the Charts tab.

2. From the Search tab, select the coverage area.

3. Search for and select an airport.
The application displays all of the selected airport charts.

• For this example, search for and select VOHY. 
All of the airport charts for Hyderabad are displayed.

4. Right-click the airport and select ADD [Airport] to 
RoutePack.

• In this example, right-click VOHY and select Add VOHY 
to RoutePack > VOHY to ESSA/VOHY to ESSA.

All of the airport charts for VOHY are added to the RoutePack 
and VOHY is designated as the first airport in the RoutePack.

Add a Destination Airport to the Route Pack

The next step is to add the destination airport to the RoutePack. 

1. From the Chart Viewer Finder window, select the Charts 
tab.

2. From the Search tab, search for and select an airport.

• For this example, search for and select ESSA. 
All of the airport charts for Arlanda are displayed.
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3. Right-click the airport and select ADD [Airport] to 
RoutePack.

• In this example, right-click ESSA and select Add ESSA to 
RoutePack > VOHY to ESSA/VOHY to ESSA.

All of the airport charts for ESSA are added to the RoutePack and 
ESSA is designated as the second airport in the RoutePack.

4. Right-click the top level of the RoutePack and click Save 
As. Save the RoutePack file to a directory location 
where you want to save all of your RoutePacks.

If your browser displays a dialog box, set the option to Save As 
and not Open With.

RoutePack Structure

RoutePacks are structured by levels.The RoutePack is the top-
most item. Under the RoutePack are the routes and alternate 
routes, and the airport charts are under the routes and alternate 
routes.

RoutePack items that appear in gray are listed as part of the 
RoutePack, but there are no charts associated because the charts 
are not included in your current coverage. This situation can 
occur when you import RoutePacks that were created in another 
application that has a different coverage. 
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When you select different levels of the RoutePack, different 
items, such as the route, associated airports, or associated charts, 
appear in the Viewer window.

View a Route in the RoutePack

Viewing enroute elements from within Chart Viewer is an 
optional service. If available, to view the route from a RoutePack:

1. From the Finder window, open the RoutePack.

2. Select the Route icon. 
The application displays the route in the Viewer window. 

View an Airport in the RoutePack

Viewing enroute elements from within Chart Viewer is an 
optional service. If available, to view an airport in the RoutePack: 

1. Right-click an airport in the RoutePack, and select Show 
Enroute. 
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Save a RoutePack

To save a RoutePack:

1. Right-click the top level of the RoutePack and select Save 
As. 

2. If your browser displays a dialog box, set the option to Save 
As and not Open With.

Save the RoutePack to a directory location where you want to 
save all of your RoutePacks.

Rename a RoutePack

To rename a RoutePack:

1. Right-click on the top level name and select Rename 
RoutePack..

2. Enter a name and select OK. 

Delete Charts from a RoutePack

To delete a chart from a RoutePack:

1. From the list of charts associated with the RoutePack, select 
the chart that you want to delete.

2. Right-click the chart and select Delete Chart.  
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Reorder Charts in a RoutePack

To reorder charts within a RoutePack:

1. Select one or more charts from the RoutePack list. 
- Hold the  key to select multiple sequential charts. 
- Hold the Ctrl key to select multiple non sequential charts.

2. Select the chart symbol and drag it to a new location within 
the RoutePack.

NOTE You cannot drag charts from one airport to another.
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Add Additional Charts to an Airport in a 
RoutePack

This example starts with a RoutePack that is missing a few charts. 
The flight is departing from Newark and arriving in Boise. The 
example adds charts to the departure airport. You could also add 
charts to the arrival airport. Note, however, that you cannot add 
charts from one airport to a different airport. 

 To add additional charts to an airport in a RoutePack:

1. From the Chart Viewer Finder window, open the 
RoutePack.

2. From the Charts tab, search for and select the airport to 
which you want to add charts.

3. Select the charts from the list of charts to add to the 
RoutePack.

4. Right-click and select Add [KEWR] to RoutePack > 
[KEWR to KBOI].
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The airport is appended to the end of the RoutePack.

5. Expand the airport, as shown in the following figure..

6. Drag the charts up to the airport where you want to place 
them..

• After you move the charts that you added, you can 
optionally delete the last airport in the RoutePack. 

7. Right-click the top level of the RoutePack and select Save 
As to save the updated RoutePack.
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Print a Single Chart in a RoutePack

To print a single chart in a RoutePack:

1. From the Chart Viewer Finder window, open the 
RoutePack.

2. Right-click the chart that you want to print.

3. Select Print Chart.

4. Select your printing preferences.
See Table 1-12, “Print Options" for detailed information 
about printing options.

5. Select Submit.
The application opens a separate window, notifies you that 
your print job is being prepared, and displays a progress 
bar. When the print job is complete, the application displays 
a PDF in this window. 

You can save the PDF, send it as an email attachment, or print it 
by using the toolbar at the top of the PDF window.

NOTE When a chart is saved as a PDF, sent as an email 
attachment to a different location, and then printed on a 
different physical printer, the person making the print is 
responsible for verifying printer settings. Printer settings cannot 
be stored within a PDF file.

Print All Charts in a RoutePack

To print all charts in a RoutePack:

1. From the Chart Viewer Finder window, open the 
RoutePack and right-click the top-most element of the 
RoutePack.

2. Select Print RoutePack. 

3. Select your printing preferences.
See Table 1-12, “Print Options" for detailed information on 
Printing options.
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4. Select Submit.
The application opens a separate window, notifies you that 
your print job is being prepared, and displays a progress 
bar. When the print job is complete, the application displays 
a PDF in this window. 

You can save the PDF, send it as an email attachment, or print it 
by using the toolbar at the top of the PDF window.

NOTE When a chart is saved as a PDF, sent as an email 
attachment to a different location, and then printed on a 
different physical printer, the person making the print is 
responsible for verifying printer settings. Printer settings cannot 
be stored within a PDF file.

Delete a RoutePack File

Use your operating system tools to delete the RoutePack files the 
same way that you would delete other files on your system. 

To delete a RoutePack:

• Browse to the file (RoutePack files have a .crf file name 
extension), select the file, and delete it.
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Accessing Manuals

From the Manuals tab, you can:

• View manuals in your coverage.

• View company-specific documents.

•  Search for a word or phrase.

• Use search criteria to limit search results.

View a Manual or Document

To view the text of a manual or document:

1. From the Finder window, select the Manuals tab.

2. Select the Contents tab.

3. Select a manual or document from the list. 

• If you select a document, the application displays the 
selected document in the Viewer window. 

• If you select a manual, a table of contents appears in the 
Finder window. A plus sign next to a topic indicates that the 
topic has subtopics. When you select a topic, its text 
appears in the Viewer window.

Search for Text in a Manual

To search for text in manual pages:

1. From the Finder window, select the Manuals tab.

2. Select the Contents tab.

3. Select a manual from the list. 

4. Select the Search tab.

5. Enter a word or phrase in the Search box. 
Wild card characters are not allowed.

6. Select Search.
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Limit the Number of Manual Text Search 
Results

Each of the preset filters lists the number of results found. Select 
a filter to apply it and limit the results; select the filter again to 
remove it.

Understanding Manual Text Search Results

Each result has a ranking score. Select a result to view it.
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Understanding Manual Text Search Parameters

The following list describes the current search parameters.

• Searches are for separate keywords. If you enter B737 
KBOI you will receive a return for every page available on 
which there is a match for the string B737 or the string 
KBOI. 

• Searches are not case-sensitive. A search for the word essa 
returns the same results as a search for the word ESSA. 

• Searches do not accept boolean expressions. A search of 
b737+KBOI will likely not return any match because the 
system searches for the literal string b737+KBOI, which 
likely does not occur within the document. 

• Wild card characters are not allowed. A search for KBO* 
will likely not return a match because the literal string 
KBO* likely does not occur.

Understanding Available Documentation

Depending on your current subscription and permissions, you 
might have access to any of the documents described in 
Table 1-11, “Available Documentation". 

Table 1-11 Available Documentation 

Document Name Document 
Type

Online 
Format

Update Frequency

Airway Manual AWM HTML Once a week to 
every other week

Visual Flight Rules Manual VFR HTML Once a week to 
every other week

Federal Aviation Regulations FAR HTML Twice per year

Aeronautical Information Manual AIM HTML Twice per year

OM-A Operations Manual Part A OM HTML Once per quarter to 
once per year

FOM - Flight Operations Manual OM HTML/ 
PDF

Once per quarter to 
once per year
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FCOM - Flight Crew Operations 
Manual

OM HTML Once per quarter to 
once per year

OM-B Operations Manual Part B OM HTML Once per quarter to 
once per year

MEL - Minimum Equipment List OM HTML Once per quarter to 
once per year

GOM - General Operations Manual OM HTML Once per quarter to 
once per year

OM-D Operations Manual Part D OM HTML Once per quarter to 
once per year

QRH - Quick Reference Handbook OM HTML Once per quarter to 
once per year

FAM - Flight Attendant Manual OM HTML/ 
PDF

Once per quarter to 
once per year

Company Handbook OM HTML Once per quarter to 
once per year

OM-C / Route Manual OM HTML/ 
PDF

Once per quarter to 
once per year

Table 1-11 Available Documentation (continued)

Document Name Document 
Type

Online 
Format

Update Frequency
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 Understanding How Pages are Listed in Manuals

Recently added pages are marked with the letter “A” to alert 
you that the chart has  a future effectivity date. 

Pages to be deleted are marked with the letter “D.” 
When there is another chart with a current effectivity date, it is 
ordered after the deleted page in the table of contents. 
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Print Selected Manual Pages

To print selected pages from a manual:

1. From the Finder window, select the Manuals tab.

2. Select the Contents tab.

3. Select a manual from the list.

4. Select a manual item from the table of contents.
The selected item appears in the Viewer window.

5. From the Chart Viewer menu, select File > Print All 
Selected. 

6. Select your printing preferences. Make sure you select 
Manuals under Related Document.

See Table 1-12, “Print Options" for detailed information about 
printing options.

7. The application opens a separate window, notifies you that 
your print job is being prepared, and displays a progress 
bar. When the print job is complete, the application displays 
a PDF in this window. 

You can save the PDF, send it as an email attachment, or print it 
by using the toolbar at the top of the PDF window.
Jeppesen e-Link Online User Guide January 2014
Copyright © 2014 Jeppesen. All rights reserved.

44



The Chart Viewer Application
Launching Chart Viewer
 

Accessing Revision Letters

As changes occur in the global airspace system, governing 
authorities forward these changes to Jeppesen. Jeppesen then 
compiles the changes and provides them to subscribers as revised 
charts. Revisions are numbered and issued in numerical 
sequence.

Each revision contains a revision letter that serves as a guide for 
efficient filing of revisions.

The Revision Letters tab is available only if this service has been 
set up by your Administrator.

View a Revision Letter

To view a revision letter:

1. From the Finder window, select the Revision Letters tab.

2. Select the coverage from the coverage list.

3. Select the revision letter to view.
The revision letter appears in the Viewer window. 

Print a Revision Letter

To print a displayed revision letter:

• Select the Print File button in the Viewer window.
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 Print All Selected Revision Letters

To print all selected revision letters:

1. From the Finder window, select the Revisions Letters tab.

2. Select the coverage from the coverage list.

3. Select all revision letters that you want to print.
- Hold the key to select multiple sequential items. 
- Hold the Ctrl key to select multiple nonsequential items.

4. From the Chart Viewer menu, select File > Print All 
Selected.

5. Select Revision Letters under Related Documents.

6. Select Submit.
The application opens a separate window, notifies you that 
your print job is being prepared, and displays a progress 
bar. When the print job is complete, the application displays 
a PDF in this window. 

You can save the PDF, send it as an email attachment, or print it 
by using the toolbar at the top of the PDF window.

Understanding Revision Dates and 
Effective Dates

The revision date refers to the date that the chart was last revised. 
The effective date refers to the date that the chart becomes 
effective.
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Printing from Within the Chart Viewer Application

Printing from within the Chart Viewer application is a two step 
process: 

1. Generate the PDF file.

2. Send the PDF file to a printer. 

NOTE The free Adobe Reader, or any other PDF reader, is 
required when working with the Portable Document Format 
(PDF). 

Print Job Setup Options

Whenever you select an item to print in Chart Viewer, a Print Job 
Setup dialog box appears. Enter the printing parameters and 
preferences  in this dialog box. Table 1-12, “Print Options" 
describes the Print Options.

Table 1-12 Print Options 

Document 
Printing 
Order 
Group

Display 
Order

Prints documents in the order 
in which they appear in Chart 
Viewer.

Standard 
Airway 
Manual 
Order

Prints documents in the order 
in which they appear in the 
Jeppesen Airway Manual. 
Does not apply to text and 
revision letters.

Documents 
Per Page 
Group

One Per Page One document is printed on a 
page.

Two Per 
Page

Two documents are printed 
on a page.
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Paper 
Group

Single Sided

Double Sided

Use Jeppesen 
Paper - Jepp 
1 up

Accommodates paper with 
holes along the left and right 
edges of the page for binding 
in the Jeppesen Airway 
Manual. In this format, 
documents print in opposite 
orientations. For example, if 
you print charts on this page, 
the header for one chart prints 
at the top of the page and the 
header for the other chart 
prints at the bottom of the 
page.

Jepp 2 up Accommodates paper with 
holes along one edge and the 
center of the page for binding 
in the Jeppesen Airway 
Manual. In this format, both 
documents print in the same 
orientation. For example, if 
you print charts on this page, 
the headers for both charts 
print at the top of the page.

Paper Size Select from the list. 

Footer User Name Select to print the user name  
in the footer.

Printed Date Select to print the date the 
document in the footer.

Printer Send to 
Printer

When this option is selected, 
information is added to the 
PDF file that sends a print job 
command when the file is 
opened.

Table 1-12 Print Options (continued)
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Margins If the default margins do not 
meet your requirements, 
change them as needed. The 
outer and inner margins are 
also referred to as left and 
right margins. The gutter is 
used to protect areas of the 
paper from being printed on, 
for example in hole-punched 
paper.

Related 
Documents 
Group

NOTE 
Related 
documents 
that cannot 
be printed 
are grayed 
out.

Terminal 
Charts

Prints terminal charts for the 
selected airport.

Airport Info Prints airport information 
for the selected airport.

Change 
Notices 

Prints terminal chart 
change notices for the 
selected airport.

Manuals Prints Manual pages for the 
selected manual.

Revision 
Letters 

Prints selected revision 
letters. 

Enroute 
Chart

Prints selected enroute 
chart.

Table 1-12 Print Options (continued)
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URL Generate 
group URL

Copies the URL to a 
browser-specific dialog 
box. 
Copy the URL from the 
browser dialog box, and 
paste it someplace else, 
such as in the body of an 
email message.

Copy and paste the URL 
using common keyboard 
commands such as Ctrl+C 
(Win),  Cmd+C (Mac),  
Ctrl+V (Win), and Cmd+V 
(Mac).

Generate Print URL 
selection is available only 
if you have the required 
permissions.

You must have the print to 
clipboard enabled in your 
browser settings.

Control 
Buttons

Load 
Preferences

Loads previously saved 
settings.

Save 
Preferences

Saves print job preferences to 
use the same print job setup 
each time.

Submit Sends the file to print.

Cancel Cancels the print job.

Table 1-12 Print Options (continued)
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Coverage Archives

To download tailored coverage archives and submit requests to 
have archives built:

• From the e-Link Online portal, select Coverage Archives.

• Select Request Archive for the coverage you want.

NOTE Archives might include AVAILABILITY_REPORT.txt. 
This report provides information about charts that are not 
available for archiving.

Enroute/Area Charts

To download or view an enroute or area chart from outside of the 
Chart Viewer application:

1. From the e-Link Online portal,  select Enroute/Area 
Charts.

2. Select the coverage code. 

3. Specify the chart types that you want to view.

4. Select Submit.
A PDF of the selected enroute or area chart appears in a 
separate window.
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NavData Services

Downloading NavData Updates

The e-Link Online portal provides secure access for downloading 
Jeppesen NavData updates each cycle. 

To download NavData:

1. From the e-Link Online portal, select NavData Services.

NOTE If you are logging in for the first time, read the license 
agreement, and then select Accept to open the Navigation 
Data page.

2. Select the link for the NavData that you want to download.

3. In the dialog box, click Save this file to disk, and then 
select OK.

4. In the Save As dialog box, navigate to the location where 
you want to save the data, and select Save.

Uploading NavData Updates

To install the downloaded NavData file:

1. Open the file from the location that you specified in step 4, 
in the previous task.

2. Follow the installation wizard instructions to install the new 
NavData.

NOTE Database files are compressed into an executable 
(.exe) format. After the NavData files are downloaded, expand 
the file, typically by double-clicking them.
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Smiths Disk Generation Tool

If you receive a Smiths database from Jeppesen, use the Smiths 
Disk Generation Tool (DGT), available from the Smiths NAV 
Database Resources link.

GE Aviation Systems Disk Generation Tool

If you receive a GE Aviation Systems database from Jeppesen, 
use the GE Disk Generation Tool (DGT) software to create 
loadable media. When you download GE Jeppesen database files, 
Jeppesen recommends that you create a folder on your local drive 
labeled “GE” and store the files in this folder.

To install the GE Disk Generation Tool (DGT) on another 
computer, access the support central website at GE 
(http://sc.ge.com/@FMD_ND) by using the same SSO ID and 
user name that you have already set up. You can then download 
the DGT onto another computer.

NOTE You might need to request an additional license file for 
the machine ID of the additional computer.

NavData Support

For assistance with electronic data downloads, contact NavData 
Technical Support at:

• 303-328-4445 (US local) 

• E-mail: navdatatechsupport@jeppesen.com
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Flight Alerts and NavData NOTAMs

Alerts 

Flight Alerts inform commercial NavData subscribers, including 
airlines, avionics companies, and aviation service providers, of 
changes and errors to databases issued by Jeppesen. 

Alerts are not designed for individual pilot notification but are 
intended to supplement the NavData NOTAMs by disseminating 
time-critical information that could have a significant impact on 
flight operations. 

Alerts contain safety-of-flight information including, but not 
limited to, incorrect turn directions, altitudes, airway changes, 
and SID/STAR/Approach procedures. This information typically 
affects Jeppesen's master database, and as a result, can affect any 
Jeppesen NavData customer or user of avionics databases derived 
from Jeppesen NavData. 

NavData NOTAMs

Jeppesen Chart Change Notices identify significant changes 
affecting Jeppesen enroute or terminal charts only. Jeppesen 
NavData Change Notices identify significant changes that affect 
Jeppesen Navigation Data only. Your aircraft flight management 
system might use these notices. 

Chart Change Notices and NavData Change Notices are available 
as they are updated. These notices enable you to review the most 
current changes within minutes of their entry into the Jeppesen 
system. These notices provide the most current information 
before the bi-weekly revisions. 

To access Flight Alerts and NavData NOTAMs:

1. From the e-Link Online portal, under Data, select Flight 
Alerts and NavData NOTAMs.

2. Select the link for an Alert or NOTAM. 
The text appears in a separate window.
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OpsData

OpsData information for flight planning provides maximum 
allowable takeoff weights based on engine-out performance.

Using an extensive array of terrain information, the computations 
are made for particular aircraft/engine configurations for a 
specific runway at a specific airport for a range of temperatures. 

Computations also consider these factors:

• Flap settings

• Aircraft characteristics

• Runway conditions

• Environmental conditions

• Obstacle clearance

You can request airports to be added to your watch/surveillance 
list that Jeppesen maintains, updates, and posts on the e-Link 
Online portal.

Working With OpsData

1. From the e-Link Online portal, under Data, select 
OpsData.

2. In the Aircraft field, select an aircraft type.

3. To narrow the search, see Table 1-13, “OpsData Search 
Filters"

Table 1-13 OpsData Search Filters

Airport 
Keyword

Enter the ICAO code, 
IATA code, full or partial 
airport name, or full or 
partial location (for 
example, Frankfurt). Wild 
card characters are not 
allowed.

Filter Select the filter type 
(ICAO, IATA, Airport 
Name, or Location).
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4. Select Search.

5. From the Airport List page, select the link for the airport 
name. 
The system displays the associated information in a 
separate browser window.

6. Select Close to return to the Airport List page. 

To display information for a different type of aircraft, select an 
aircraft type in the field under Change Aircraft, and then select 
Go.

OpsData Request

1. From the e-Link Online portal, select OpsData Request.

2. Enter the appropriate values, and then select Submit.

After your request has been submitted, Jeppesen adds the airport 
to your watch list and posts the updated watch list on the e -Link 
Online portal.
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Publications

The Document Services page displays a customized list of 
available manuals and documents to view and print from the e-
Link portal. 

Document Services

View a Manual or Document

To view a manual or document from the Document Services 
page:

1. From the e-Link Online portal, under Publications, select 
Document Services.

2. Select a manual or document title to open the file in a 
separate browser window. 

• If you select a manual, a table of contents appears in the 
Finder window. A plus sign next to a topic indicates that the 
topic has subtopics. When you select a topic, its text 
appears in the Viewer window.

Search for Text in a Manual

To search for text in a manual from the Document Services page:

1. From the e-Link Online portal, under Publications, select 
Document Services.

2. Select a manual to open the file in a separate browser 
window. 

3. Enter the search text in the Search field at the top left of the 
page.

4. Select Go.
Search results are listed in the right pane.

5. Select a search result to view the text.
January 2014 Jeppesen e-Link Online User Guide
Copyright © 2014 Jeppesen. All rights reserved.

57



Reports
Content List
 

Print a Document File

To print a displayed document file accessed from the Document 
Services page:

• Select the Print File button in the Viewer window.

Reports

Depending on your account permissions and services, you may 
find several listings under Reports on the e-Link Online portal.

Content List

A content list is a log of information for a paper chart or text 
manual. Every sheet, front and back, contained in the Jeppesen 
Airway Manual appears in the order designated by Jeppesen. You 
can compare the content list to the Airway Manual to ensure that 
complete, current content is in the correct order. 

If information is missing from a manual, contact Jeppesen for the 
material. 

View the Content List

To view the current content list:

1. From the e-Link Online portal, select Content List.

2. Select a coverage in either text or HTML format. 
The content opens in a separate window.
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Create a Dynamic Content List

You can dynamically generate a custom content list that includes 
only the fields that you need. A dynamic consolidated content list 
includes both standard and tailored coverages.

To dynamically generate a content list:

1. From the e-Link Online portal, select Content List.

2. Select the Click here link at the top of the page.

3. Under Report Fields, select at least one field.

4. Under Coverage Codes, select at least one coverage code.

5. Under Report Type group, select either Current Revision, 
or Advanced Revision.

6. Select Submit.

The application generates a comma-separated values file (*.csv 
file) which you can import and open in a spreadsheet application 
(such as Microsoft Excel), or a text editor of your choice.

Advanced Revision Letters

Advanced revision letters notify you of advanced changes to 
come that affect the Jeppesen Airway Manual. The revision cycle 
occurs on a weekly or biweekly basis. Advanced revision letters 
are automatically generated as soon as the cutoff date for a 
revision period is reached. Advanced revision letters contain a 
DRAFT watermark to indicate changes that are not finalized and 
posted. 

View Advanced Revision Letters

To view advanced revision letters:

1. From the e-Link Online portal, select Advanced Revision 
Letters.
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2. Select a coverage to open in a separate window.

NOTE The date/time stamp appears only if there has been a 
change to the advanced revision activity file. If the generation 
process for advanced revision letters fails, the Last Updated 
section shows dates and times from the last successful 
generation process.

Dynamically Create Advanced Revision 
Letters

Dynamically generated advanced revision letters include advance 
changes to come for tailored charts; it does not include the 
standard charts.

To dynamically generate advanced revision letters:

1. From the e-Link Online portal, select Content List.

2. Select “Click here to generate a dynamic consolidated 
content list.” 

3. Under Report Fields, select at least one field.

4. Under Coverage Codes, select at least one Coverage Code. 

5. Under Report Type group, select Advanced Revision.

6. Click Submit.

The application generates a comma-separated values file 
(*.csv file) that you can import and open in a spreadsheet 
application (such as Microsoft Excel), or a text editor of 
your choice.
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Revision Cutoff Schedule

Without exception, Jeppesen adheres to a cutoff schedule with 
regard to accepting changes to your tailored manual pages, 
contents, or quantities. For your convenience, the weekly cutoff 
schedules are accessible from the e-Link Online portal.

View the Weekly Revision Cutoff Schedule

To view the weekly cutoff schedule for revisions:

• From the e-Link Online portal, select Revision Cutoff 
Schedule. 
The weekly cutoff schedules for revisions are listed on 
the page..

Billing Reports

A billing report is an itemization of revisions to the content of 
your tailored manuals so that you can correlate the charges on the 
Jeppesen invoice. Billing reports are automatically generated by 
Jeppesen at the beginning of each month.

The billing report extracts information from the Revision Control 
System (RCS) and consolidates all revisions into the report. 
Revisions are listed by sheet number for the affected tailored 
manual. In some cases, a revised page applies to only one tailored 
manual. In other cases, a revised page applies to multiple tailored 
manuals.

Table 1-14 Revision Cutoff Information

Revision Date Displays the date of the current revision.

Cutoff Date Displays the last date that changes are 
accepted.

The cutoff date applies to revised and new 
terminal charts and text, address, and 
quantity changes.
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View Your Billing Report

To view your billing report:

1. From the e-Link Online portal, select Billing Reports.

2. Select a filename. 
The billing report appears in a separate browser window.

EFB Management Tools

Launch CAT

The Configuration Administration Tool (CAT) is a web-based 
application that is available within the Chart Viewer application.

To launch CAT:

• From the e-Link Online portal, select Launch CAT.

Launch DDM

The Data Distribution and Management (DDM) Application 
Service Provider is a web-based application that enables you to 
manage the distribution and delivery of data, configuration files, 
and software, collectively referred to as content, used on board an 
aircraft. DDM Online Help is available within the application.

To launch DDM:

• From the e-Link Online portal, select Launch DDM.
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Chapter 4: User 
Administration

This section describes key administration tasks performed by data 
administrators who manage the Chart Viewer application and the 
e-Link Online portal.

The Chart Viewer Application

Create a Credential Pass Through for the Chart Viewer 
Application

To directly access the Chart Viewer application from your own 
web page, use the following sample script. 

Sample HTML Script
<!DOCTYPE html PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN"
"http://www.w3.org/TR/html4/loose.dtd">
<html>
<head>
<meta http-equiv="Pragma" content="no-cache">
<title>Airline Name Here</title>
</head>
<body onLoad="javascript:document.forms.loginForm.submit();">
<form action="https://ww1.jeppesen.com/icharts/index.jsp" 
method="post" name="loginForm">
<input type="hidden" name="login-username" 
value="firstname.lastname">
<input type="hidden" name="login-password" value="password1234">
</form>
</body>
</html>
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Where:

• “Airline Name here” is replaced with your airline name.

• “firstname.lastname” is replaced with your Jeppesen e-Link 
Online user name.

• “password1234” is replaced with your Jeppesen e-Link 
Online password.

e-Link Online Portal

Through e-Link Online User Administration page, you set 
permissions to view information through the Chart Viewer 
application, the e-Link Online portal, and mobile devices.

Getting Started

Logging In to e-Link Online User 
Administration

You can access the e-Link Online User Administration page in a 
couple of ways. Both require that you have permissions to access 
the user administration functionality. 

NOTE If you do not have e-Link Online User Administration 
access, contact your Jeppesen representative.

You can access the e-Link Online User Administration page by 
navigating to:  https://www.jeppesen.com/useradmin. 

You can also log in to the e-Link Online User Administration 
page from the Jeppesen website. 
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To log in to e-Link Online User Administration page from the 
Jeppesen website: 

1. Navigate to: http://www.jeppesen.com

2. Select the ACCOUNT/LOGIN Jeppesen Customers box 
at the top right of the page.

3. Select Aviation Account.

4. Enter your e-Link Online user name and password.

5. Select Login.

6. From the e-Link Online portal, select Manage Users and 
Groups.

NOTE You can return to the e-Link Online portal page while 
logged in to the User Administration page by selecting eLink 
Portal. See Return to the e-Link Online Portal.

Logging Out of e-Link Online User 
Administration

 When you log out, always use the log-out procedure. 

To log out of Jeppesen e-Link Online User Administration page:

• Select Logout at the top left of the page.

NOTE  If you close the browser without first logging out, as a 
security measure, the Jeppesen server can hold the session ID, 
and will not allow you to log back in until you log out or the 
session ID expires. 
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Return to the e-Link Online Portal 

To return to the e-Link Online portal:

• From the User Administration page, select eLink Portal.

User Administration Conventions

e-Link Online user administration conventions are: 

• Required fields are marked with an asterisk (*).

• Sortable columns are indicated by an underlined column 
heading that appears in white. The current sort column is 
indicated by a small white arrow pointing up for ascending 
(A to Z, and 1 to 10) or down for descending (Z to A, and 
10 to 1). Select multiple times on a single column header to 
alternate the sorting between ascending and descending 
order on that column.

• Where appropriate, you can filter data by entering a whole 
or partial search term in the field next to the Filter button at 
the top of a page, and then selecting Filter.
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Create a Credential Pass Through for the e-Link Online 
Portal

To directly access the e-Link Online portal from your own web 
page, use the following script. 

Sample HTML Script

<!DOCTYPE html PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN" 
"http://www.w3.org/TR/html4/loose.dtd">

<html>
<head>
<meta http-equiv="Pragma" content="no-cache">
<title>Airline Name Here</title>
</head>
<body onLoad="javascript:document.forms.loginForm.submit();">
<form action="https://ww1.jeppesen.com/elink/login.do" method="post" 
name="loginForm">
<input type="hidden" name="j_username" value="firstname.lastname">
<input type="hidden" name="j_password" value="password1234">
</form>
</body>
</html>

Where:

• “Airline Name here” is replaced with your airline name.

• “firstname.lastname” is replaced with your Jeppesen e-Link 
Online user name.

• “password1234” is replaced with your Jeppesen e-Link 
Online password.
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Customizing Your e-Link Online Web Page

You can create and maintain content for your company e-Link 
Online web site through the Manage Content functionality.

Change the e-Link Online Portal Logo

By default, the e-Link Online portal displays the Jeppesen logo. 
To change the default logo:

1. From the e-Link Online User Administration page, select 
Manage Content.

2. Select Edit Content in the upper right of the Manage 
Content page.

3. Select Browse and navigate to the logo file you want to use

4. Select the Upload New Logo Image button.

NOTE The new logo must be in GIF format, no larger than 
20kB in size, and 170px wide by 110px high.

Create and Edit Web Content

You can create and maintain content for your e-Link Online 
website.

1. From the e-Link Online User Administration page, select 
Manage Content. 

2. Select Edit Content in the upper right of the Manage 
Content page. 

3. Select the Enable “Contact Support” link in main 
navigation option to make the contact support link on your 
web page active. 

4. Enter your Homepage content. 

5. Select the Enable “Feedback Form” section on Contact 
page option to activate the Feedback Form link on the 
Contact page. 
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6. Enter a heading for the Feedback Form section on the 
Contact page.

7. Enter the text to appear under Send Us Your Feedback.

8. Enter the email addresses for the recipients of the 
completed Feedback forms. 

NOTE For multiple feedback form recipients, you must insert 
a hard return after each entry. 

• Select Add Another Section to add more sections.

• Select Delete Section to remove a section.

• Select Cancel to return to the Manage Content page without 
saving any information.

9. Select Save Content to save the information.

Update Your User Profile

Depending on your permissions, you may be able to edit your 
name and email address.

To edit your profile:

1. From the e-Link Online User Administration page, select 
View Profile at the top of the menu.

2. From User Profile page, select Edit.

3. Make changes to first name, last name or email.

4. Select Submit.

•
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Setting Up Permissions and Uploading 
Content

To set up users with access to content through the e-Link Online 
portal: 

1. Add a group with permissions.

2. Add users to the group.

3. If applicable, upload any company-specific documents and 
assign to the group.

Managing Groups

Setting up groups enables you to efficiently assign content to a 
group of users.

Add a Group

To add a group and assign privileges:

1. From the User Administration page, select Add New 
Group.

2. Enter the appropriate values in the fields. See Table 1-15, 
“Add Group Settings"  and Table 1-16, “Group 
Privileges"for a detailed list of the settings.

3. Select the Add Coverages button.

4. Select the coverages to assign to this group.
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5. Select Submit at the bottom of the page.

NOTE You can create a template to use for batch uploading 
users by performing a batch download of all the current users, 
and then using that spreadsheet as a template to batch upload 
new users. 

Table 1-15 Add Group Settings

Group Name Enter a name for the group 
(required field).

Group Description Enter a brief description of 
the group.

Status When Active is selected, 
the group can access e-
Link Online.

Customer Accounts Shows the accounts that 
are currently applied to 
this group. 

Available Coverages Shows the number of 
coverages that are 
currently selected. 

Associated OpsData  Aircraft Shows the number of 
aircraft that are entered in 
the OpsData files.

Document Services Select documents to 
associate with the group.

Privileges Select all privileges that 
apply to this group. See 
Table 1-16, “Group 
Privileges"for list of 
privileges.

Table 1-16 Group Privileges 

Administrator Allows access to e-Link 
Online user 
administration.
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Airside Global Services 
Airline 

Allows an airline access to 
the Global Logistics 
application.

Airside Global Services 
Access 

Allows access to Global 
Logistics application.

Airside Global Services DEN Allows access to Global 
Services users located in 
Denver.

Batch User Upload Enables batch user 
upload/download 
privileges.

CAT - Airport Maps Allows access to the TPA 
module.

CAT - BOESysConfig Allows access to the BOE 
System Configuration 
module.

CAT - Basic User Consumer personnel who 
build packages in CAT.

CAT - Boeing e-Plane 
Module

Allows access to the 
Boeing e-Plane module.

CAT - Comm Management Allows access to the 
comm management 
module.

CAT - EFB Admin Consumer personnel who 
can administer EFB via 
CAT.

CAT - ELB Allows access to the ELB 
module.

CAT - FID Allows access to the FID 
module

CAT - Fault Reporting Allows access to the fault 
reporting module.

CAT - IT Super User for CAT.

Table 1-16 Group Privileges (continued)
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CAT - Performance Allows access to the 
performance module.

CAT - Production Consumer personnel for 
CAT.

CAT - Terminal Charts Allows access to the 
terminal charts module.

CAT - Video Allows access to the video 
module.

CAT - eDocs Allows access to the 
eDocs module.

Chart Viewer Enroute 
Privilege

Enables enroute features 
to be viewed from within 
the Chart Viewer 
application. 

Coverage Archive Download Enables the group to 
download of PDF archives 
of tailored charts.

DDM - Airline Manager Consumer personnel who 
decide if a package is 
acceptable.

DDM - Archiver DDM Archiver 

DDM - Content Manager Allows consumer 
personnel to decide which 
packages to associate with 
which recipients.

DDM - Content Publisher Allows supplier personnel 
who physically upload and 
describe contents to make 
it available through the 
delivery network to 
consumers.

DDM - Content Reviewer  Allows consumer 
personnel who decide if a 
package is acceptable.

Table 1-16 Group Privileges (continued)
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DDM - Recipient Manager Allows consumer 
personnel to create and 
maintain recipients.

DDM - Review Manager Allows consumer 
personnel to set up the 
quality assurance process 
and decide who will 
review which packages.

DDM - Reviewer DDM Reviewer 4.1 only.

DDM 4 Allows access to e-Link 
for DDM 4.1.

Document Repository - View Allows a Jeppesen 
administrator to view files.

E4W/EC4W - JWC 
Enterprise Weather

Allows access to JWC 
Enterprise Weather

EFB - Class 3 Allows access to the 
Electronic Flight Bag, 
Class Three.

Enroute and Area Charts Allows download of large 
enroute and area charts.

Mobile EText Manuals Allows access to eText 
manuals on mobile 
devices.

Mobile Tailored Coverages Allows access to tailored 
charts on mobile devices.

NavData Services Allows access to NavData 
files.

OPS Data Allows access to OPS 
Data files.

View Event Logs Allows access for the 
group to view event logs.

Web Group Management Allows access to the group 
management pages.

Table 1-16 Group Privileges (continued)
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Web User Management Allows access to the web 
user management pages.

eLink Advanced Revision 
Letters

Allows access to the 
Advanced Revision 
Letters activity.

eLink Billing Reports Allows access to the 
electronic 30 reports.

eLink Content List Allows access to content 
lists.

eLink Java Chartviewer Allows access to the Chart 
Viewer application for all 
charting services in e-
Link.

eLink PDF Content Allows access to the text.

eLink Portal Login The default privilege for 
airline users.

eLink Production Schedules Allows access to 
production schedules.

eLink Revision Letters Allows access to revision 
letters.

eLink TCL Content Allows access to 
electronic charts.

eLink eText Documents - 
Access 

Allows access the 
Document Services page.

eText Documents - Add Allows privilege to add 
new eText documents.

eText Documents - Delete Allows privilege to delete 
available eText 
documents.

eText Documents - Edit Allow privilege to modify 
eText document 
properties.

eText Documents - Upload Allows privilege to upload 
customer documents.

Table 1-16 Group Privileges (continued)
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View Groups

To view a group profile:

1. From the e-Link Online User Administration page, select 
Manage Groups.

2. Select a group from the Group Name column to view the 
group profile.

Edit a Group

To edit a group:

1. From the e-Link Online User Administration page, select 
Manage Groups.

2. Select a group from the Group Name column.

3. Select the Edit Group Settings button.

4. Make the required changes. 
See Table 1-15, “Add Group Settings"andTable 1-16, 
“Group Privileges" for detailed information about the 
settings. 
See Upload Customer Documents on page 81 for detailed 
information on assigning uploaded content to users.

5. Select Submit at the bottom of the page.

Delete a Group

1. From the e-Link Online User Administration page, select 
Manage Groups.

2. Select a group from the Group Name column.

3. Select the Delete Group button.

4. Select OK to confirm the deletion.
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Managing Users

After you have created groups, the next step is to add users to a 
group. e-Link Online provides the following methods for adding 
users:

• Add users one at a time.

• Batch upload multiple users, which enables you to upload 
users using a comma-separated value (CSV) file.

Add a Single User

To add a single user to a group:

1. From the e-Link Online User Administration page, select 
Add New Web User.

2. Select a group from the Group Name column.
Enter the appropriate values. See Table 1-17, “Add New 
Web User Fields"for detailed information about new user 
fields. 

3. Select Submit at the bottom of the page.

Table 1-17 Add New Web User Fields

Field Requirements

Username • Must be between 6 and 20 characters. 

• Can contain alphanumeric characters 
(Aa–Zz or 0–9), the % sign, the @ sign, 
the underscore (_), the dash (–), and the 
period (.). 

• Can be a well-formed email address 
(reference RFC 2822). 

• Cannot contain blank spaces.

Email Enter the full email address.
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Batch Upload of Users

You can use a comma-separated value (CSV) file to upload 
multiple users to provide them access to the e-Link Online portal.
The user CSV file must be set up as described in Setting Up a 
User CSV File.

To perform a batch upload of users:

1. From the e-Link Online User Administration page, under 
Manage Users, select Batch User Upload/Download.

2. At Add File, browse to the csv file and select it.

3. At Choose Option, select Replace existing users only if 
you want to overwrite a file.

Password • Auto generate and send password is 
selected by default. 

• To create a password, select the 
Manually change password option and 
enter the password in the field. 

You can send the manually-set password 
in an email message; however, this 
action is not required if you have 
another notification method in place.

First Name The first name of the user.

Last Name The last name of the user.

Status The default is Active; a status of Inactive 
blocks the user from accessing content from 
the e-Link Online portal.

Group A user must be assigned to a Group.

Table 1-17 Add New Web User Fields

Field Requirements
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4. At Upload File, select Upload Users.

NOTE You can create a template to use for batch uploading 
users by performing a batch download of all the current users, 
and then using that spreadsheet as a template to batch upload 
new users.

Setting Up a User CSV File

You can use any common spreadsheet program, such as 
Microsoft Excel, OpenOffice CALC, or Google Spreadsheets, to 
create the  user CSV file. 

The spreadsheet should contain seven columns: action, user 
name, password, first name, last name, e-mail, and groups.

Batch Download of Users

To perform a batch download of e-Link Online users:

1. From the e-Link Online User Administration page, under 
Manage Users, select Batch User Upload/Download.

2. Under Download Users to CSV file, select Download.
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View Users

To view a group’s users and privileges:

1. From the e-Link Online User Administration page, select 
Manage Users.

2. From the Manage Users page, select each user name to 
view.

Edit a User

To edit a user profile:

1. From the e-Link Online User Administration page, select 
Manage Users.

2. From the Manage Users page, select the user name.

3. From the View Web User Profile page, select Edit Web 
User Profile on the top right corner of the page.

4. Make the required changes.

5. Select Save at the bottom of the page.

Delete a User

To delete a user from the database:

1. From the e-Link Online User Administration page, select 
Manage Users.

2. From the Manage Users page, select the user name.

3. From the View Web User Profile page, select Delete User 
on the top right corner of the page.

4. In the dialog box, click OK to confirm the deletion.
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Managing Customer Document Uploads

After you upload documents (PDF files) using the e-Link Online 
portal, the files can be made available to the user from the: 

• Chart Viewer application (from the Manuals tab). For more 
information on accessing the documents, see Accessing 
Manuals on page 39.

• e-Link Online portal (from the Document Services page). 
For more information on accessing the documents, see 
Document Services on page 57.

• FliteDeck application on a mobile device. For more 
information on accessing the documents, see FliteDeck help 
available from within the FliteDeck application.

Upload Customer Documents

You can upload PDF files and make them available to a group:

1. From the e-Link Online User Administration page, select 
Manage Customer Document Uploads.

2. Select Upload new document at the top right of the page.

3. Enter a name for the document.

NOTE Limit the title of your document to 80 characters and 
avoid the use of special characters outside the basic ASCII 
character set.

4. In the Mime Type field, select A PDF Document. 

5. To make the file available to mobile devices, select Make 
Available to Mobile. 
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6. Enter the location of the PDF file or browse to select it.

NOTE For PDF files to be uploaded, use these filenaming 
conventions. Limit the filename to 50 characters (including the 
file extension). Use all letters (A-Z and a-z), and numbers (0-9), 
dashes(-) and underscores ( _ ). Use a period before the file 
extension but do not use multiple period characters in a row. Do 
not use spaces, commas, parentheses, plus signs, or special 
characters (* # % & ? / \ | : ; ' " = $ @ ^ { } [ ] < >).

7. Select Submit.

8. From the e-Link Online User Administration page, select 
Manage Groups.

9. Select a group from the Group Name column.

10. Select Edit Group Settings.

11. Select the file yo want to upload from the Document 
Services section.

12. Select Submit.

Update Customer Documents

To update previously uploaded content:

1. From the e-Link Online User Administration page, select 
Manage Customer Document Uploads.

2. Select Update in the row for the file you want to update.

3. Select Browse to locate and select the document (PDF) you 
want to use for the update.

4. Select Submit.
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Delete Customer Documents

To delete previously uploaded content:

1. From the e-Link Online User Administration page, select 
Manage Customer Document Uploads.

2. Select Delete in the row for the file you want to delete.

3. Select OK to confirm the deletion.
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